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Disclaimer

Specifications written in this document are believed to be accurate, but are not guar-
anteed to be entirely free of error. The information in this manual is subject to
change for functional or performance improvements without notice. Please make sure
your manual is the latest edition. While the information herein is assumed to be
accurate, SEGGER Microcontroller GmbH & Co. KG (the manufacturer) assumes no
responsibility for any errors or omissions. The manufacturer makes and you receive
no warranties or conditions, express, implied, statutory or in any communication with
you. The manufacturer specifically disclaims any implied warranty of merchantability
or fitness for a particular purpose.

Copyright notice

You may not extract portions of this manual or modify the PDF file in any way without
the prior written permission of the manufacturer. The software described in this doc-
ument is furnished under a license and may only be used or copied in accordance
with the terms of such a license.

© 2010 SEGGER Microcontroller GmbH & Co. KG, Hilden / Germany

Trademarks

Names mentioned in this manual may be trademarks of their respective companies.

Brand and product names are trademarks or registered trademarks of their respec-
tive holders.

Contact address

SEGGER Microcontroller GmbH & Co. KG

In den Weiden 11
D-40721 Hilden

Germany

Tel.+49 2103-2878-0
Fax.+49 2103-2878-28
Email: support@segger.com
Internet: http://www.segger.com

Manual versions

This manual describes the latest software version. If any error occurs, please inform
us and we will try to assist you as soon as possible.

For further information on topics or routines not yet specified, please contact us.

Software versions

Refer to FlasherSTM8.html for information about the changes of the software ver-
sions.

Revision Date By Explanation

4 100624 OO

Updated documentation to renamed binaries in 
Flasher STM8 software and documentation pack-
age.
Updated all screenshots.

3 100607 OO Chapter "Command Line Interface":
- New command line command "-merge"

2 100526 OO

Chapter "Getting started":
- Updated menu explanations
Chapter "Command Line Interface":
- Updated available commands

1 091210 OO Initial Version
Table: List of manual versions
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About this document
Assumptions

This document assumes that you already have a solid knowledge of the following:

� The target processor
� DOS command line.

How to use this manual
This manual explains all the functions that Flasher STM8 Software offers.

Typographic conventions for syntax

This manual uses the following typographic conventions:

Style Used for

Body Body text.

Keyword
Text that you enter at the command-prompt or that appears on the 
display (that is system functions, file- or pathnames).

Parameter Parameters in API functions.

Sample Sample code in program examples.

Reference Reference to chapters, tables and figures or other documents.

GUIElement Buttons, dialog boxes, menu names, menu commands.

Emphasis Very important sections

Table 1.1: Typographic conventions
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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EMBEDDED SOFTWARE
(Middleware)

emWin
Graphics software and GUI
emWin is designed to provide an effi-
cient, processor- and display control-
ler-independent graphical user 
interface (GUI) for any application that 
operates with a graphical display. 
Starterkits, eval- and trial-versions are 
available.

embOS
Real Time Operating System
embOS is an RTOS designed to offer 
the benefits of a complete multitasking 
system for hard real time applications 
with minimal resources. The profiling 
PC tool embOSView is included. 

emFile
File system
emFile is an embedded file system with 
FAT12, FAT16 and FAT32 support.  
emFile has been optimized for mini-
mum memory consumption in RAM and 
ROM while maintaining high speed. 
Various Device drivers, e.g. for NAND 
and NOR flashes, SD/MMC and Com-
pactFlash cards, are available.

emUSB
USB device stack
A USB stack designed to work on any 
embedded system with a USB client 
controller. Bulk communication and 
most standard device classes are sup-
ported.

SEGGER TOOLS

Flasher 
Flash programmer
Flash Programming tool primarily for  microcon-
trollers.

J-Link
JTAG emulator for ARM cores
USB driven JTAG interface for  ARM cores.

J-Trace
JTAG emulator with trace
USB driven JTAG interface for ARM cores with 
Trace memory. supporting the ARM ETM (Embed-
ded Trace Macrocell).

J-Link / J-Trace Related Software
Add-on software to be used with SEGGER�s indus-
try standard JTAG emulator, this includes flash 
programming software and flash breakpoints.

Table 1.1: 

SEGGER Microcontroller GmbH & Co. KG develops
and distributes software development tools and ANSI
C software components (middleware) for embedded
systems in several industries such as telecom, medi-
cal technology, consumer electronics, automotive
industry and industrial automation. 

SEGGER�s  intention is to cut software development-
time for embedded applications by offering compact flexible and easy to use middleware,
allowing developers to concentrate on their application.

Our most popular products are emWin, a universal graphic software package for embed-
ded applications, and embOS, a small yet efficent real-time kernel. emWin, written
entirely in ANSI C, can easily be used on any CPU and most any display. It is comple-
mented by the available PC tools: Bitmap Converter, Font Converter, Simulator and
Viewer. embOS supports most 8/16/32-bit CPUs. Its small memory footprint makes it
suitable for single-chip applications. 

Apart from its main focus on software tools, SEGGER developes and produces program-
ming tools for flash microcontrollers, as well as J-Link, a JTAG emulator to assist in devel-
opment, debugging and production, which has rapidly become the industry standard for
debug access to ARM cores.

Corporate Office:
http://www.segger.com

United States Office:
http://www.segger-us.com
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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Chapter 1

Introduction
The following chapter introduces Flasher STM8 Software, highlights some of its
features, and lists its  requirements on host and target systems.
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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1.1 What is Flasher STM8 Software?
Flasher STM8 Software is a stand-alone flash programming software for PCs running
Microsoft Windows. The following Microsoft Windows versions are supported:

� Microsoft Windows 2000
� Microsoft Windows XP
� Microsoft Windows XP x64
� Microsoft Windows 2003
� Microsoft Windows 2003 x64
� Microsoft Windows Vista
� Microsoft Windows Vista x64

Flasher STM8 Software has an intuitive user interface and makes programming flash
devices convenient. Flasher STM8 Software requires a Flasher STM8, flasher for
STM8 cores, to interface to the hardware. Flasher STM8 Software supports a feature
called smart read back, which only transfers non-blank portions of the flash, increas-
ing the speed of read back greatly. These features along with its ability to work with
any STM8 chip makes it a great solution for most projects.

1.1.1 Features
� Any STM8 core supported.
� STM8 microcontroller (internal flash) support.
� Smart read back: only non-blank portions of flash are transferred and saved.
� Verbose logging of all communication.
� .hex, .mot, .srec, and .bin support.
� Intuitive user interface.
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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1.2 Assumptions
This user manual assumes that you already possess working knowledge of the
Flasher STM8 device. If you feel that your knowledge of Flasher STM8 is not
sufficient, we recommend the Flasher STM8 manual, which describes the device and
its use in detail.
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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1.3 Requirements

1.3.1 Host
Flasher STM8 Software requires a PC running Microsoft Windows 2000 or later with a
free USB port dedicated for a Flasher STM8.  A network connection is required only if
you want to use Flasher STM8 Software together with a remote Flasher STM8 device.

1.3.2 Target
A SWIM interface must be available on the target device to establish the connection
with the host system. A network connection must be available if and only if it is
desired to connect to the Flasher through TCP/IP from a remote system.
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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Chapter 2

Getting Started
This chapter presents an introduction to Flasher STM8 Software. It provides an
overview of the included sample projects and describes Flasher STM8 Software�s
menu structure in detail.
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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2.1 Setup
The Flasher STM8 setup procedure required in order to work with Flasher STM8 Soft-
ware is described in the Flasher STM8 User Guide. The Flasher STM8 User Guide is
part of the Flasher STM8 software package which is available for download under
www.segger.com.

2.1.1 What is included?
The following table shows the contents of all subdirectories of the Flasher STM8
software and documentation pack with regard to Flasher STM8 Software:

Directory Contents

.
The Flasher STM8 Software application. Please refer to 
the Flasher STM8 manual for more information about 
the other Flasher related tools.

.\Doc
Contains the Flasher STM8 Software documentation and 
the other Flasher related manuals.

.\ETC\FlasherSTM8\
Two *.csv files for the Flasher STM8 Software internal 
management of supported MCU�s und flash chips.

.\Sam-
ple\FlasherSTM8\Pro-
jectFiles\

Contains sample projects with good default settings 
(see section Sample Projects on page 16 for further 
details).

Table 2.1: Flasher STM8 Software directory structure
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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2.2 Using Flasher STM8 Software for the first time
Start Flasher STM8 Software from the Windows Start menu. Flasher STM8 Software�s
main window will appear, which  contains a log window at the bottom and the
Project window of a default project on the left. The application log will initially
display:

� The version and time of compilation for the Flasher STM8 Software application.
� The version and time of compilation for the STM8 DLL.
� The number of supported flash devices.
� The number of supported MCU devices.
� The location of the default project.

The Project window contains an overview of the current project settings (initially
Flasher STM8 Software opens a default project).
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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2.2.1 Sample Projects
If you are new to Flasher STM8 Software, it might be a good idea to open one of our
sample projects to familiarize yourself with the application. You find those project
files in the Projects subdirectory of Flasher STM8 Software�s installation directory.
Once you have opened a project file, the project window contains the relevant project
settings, e.g. chip type, RAM size etc. The settings are known to be good defaults for
the respective devices. You may then continue to open your own data files to actually
program your device. The table below contains the included project files together
with a short description.

Project Description

STM8L101K3.jflash STM8L101K3 with internal flash memory
STM8S208MB.jflash STM8S208MB with internal flash memory

Table 2.2: List of sample Flasher STM8 Software projects
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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2.3 Menu structure
The main window of Flasher STM8 Software contains seven drop-down menus (File,
Edit, View, Target, Options, Window, Help). Any option within these drop-down
menus that is followed by a three period ellipsis (...), is an option that requires more
information before proceeding.

File menu elements

Edit menu elements

View menu elements

Command Description

Open...
Opens a data file that may be used to flash the target 
device. The data file must be an Intel HEX file, a Motorola 
S file, or a Binary file (.hex, .mot, .srec, or .bin).

Merge Merges two data files (.hex, .mot, .srec, or .bin).
Save Saves the data file that currently has focus.

Save As... Saves the data file that currently has focus using the 
name and location given.

New Project Creates a new project using the default settings.

Open Project...
Opens a Flasher STM8 Software project file. Note that 
only one project file may be open at a time. Opening a 
project will close any other project currently open.

Save Project Saves a Flasher STM8 Software project file.

Save Project As... Saves a Flasher STM8 Software project file using the 
name and location given.

Close Project Closes a Flasher STM8 Software project file.

Save programmer con-
figuration file...

Saves a Flasher STM8 Software configuration as pro-
grammer configuration file using the name and location 
given.

Save programmer data 
file...

Saves the content of the memory window as programmer 
data image file using the name and location given.

Download to program-
mer

Download configuration and data to program to a con-
nected programmer for stand alone usage.

Recent Files > Contains a list of the most recently open data files.
Recent Projects  > Contains a list of the most recently open project files.
Exit Exits the Flasher STM8 Software application.

Table 2.3: File menu elements

Command Description

Relocate... Relocates the start of the data file to the supplied hex 
offset from the current start location.

Delete range...

Deletes a range of values from the data file, starting and 
ending at given addresses. The End address must be 
greater than the Start address otherwise nothing will be 
done.

Table 2.4: Edit menu elements

Command Description

Log Opens and/or brings the log window to the active win-
dow.

Project Opens and/or brings the project window to the active 
window.

Table 2.5: View menu elements
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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Target menu elements

Command Description

Connect
Creates a connection through the Flasher using the con-
figuration options set in the Project settings... of the 
Options drop-down menu.

Disconnect Disconnects a current connection that has been made 
through the Flasher.

Test >

Two test functions are implemented "Generates test 
data" generates data which can be used to test if the 
flash can be programmed correctly. The size of the gen-
erated data file can be defined.
"Test speed..." writes data of a specified size to a defined 
address, reads the written data back and measures the 
up- and download speed.
"Hardware >" allows testing of proper functionality of the 
Flasher RS232 interface signals.

Secure chip Secures the MCU.
Unsecure chip Unsecures the MCU.
Check blank Checks flash to see if it is empty.
Fill with zero Fills all selected flash sectors with zero.
Erase sectors Erases all selected flash sectors.
Erase chip Erases the entire chip.
Program Programs the chip using the currently active data file.

Program & Verify Programs the chip using the currently active data file and 
then verifies that it was written successfully.

Auto

The Auto command performs a sequence of steps. It con-
nects to the device, erases sectors and programs the chip 
using the currently active data file before the written 
data is finally verified. The range of sectors to be erased 
can be configured through the Flash tab of the Project 
settings dialog and through the Global settings dialog. 
See chapter Settings on page 21 for further details.

Verify Verifies the data found on the chip with the data file.

VerifyCRC >

Verifies the CRC. There are three ways in which the CRC 
can be verified.
"Affected sectors" verifies the CRC of the affected sec-
tors.
"Selected sectors" verifies the CRC of the selected sec-
tors.
"Entire chip" verifies the CRC of the entire chip.

Read back >

Reads back the data found on the chip and creates a new 
data file to store this information. There are three ways 
in which the data can be read back. The Selected sectors 
identified on the Flash tab of the Project Settings... found 
in the Options drop-down menu may be read back. The 
Entire chip may be read back. A specified Range... may 
be read back.

Start Application Starts the application found on the chip.
Table 2.6: Target menu elements
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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Options menu elements

Window menu elements

Help menu elements

Command Description

Project settings...

Location of the project settings that are displayed in the 
snapshot view found in the Project window of the Flasher 
STM8 Software application as well as various settings 
needed to locate the Flasher and pass specified com-
mands needed for chip initialization.

Global settings... Settings that influence the general operation of Flasher 
STM8 Software.

Table 2.7: Options menu elements

Command Description

Cascade Arranges all open windows, one above the other, with the 
active window at the top.

Tile Horizontal Tiles the windows horizontally with the active window at 
the top.

Tile Vertical Tiles the windows vertically with the active window at the 
left.

Table 2.8: Window menu elements

Command Description

Flasher STM8 Software 
User�s Guide

Shows this help file in a PDF viewer such as Adobe 
Reader.

Flasher STM8 User�s 
Guide

Shows the Flasher STM8 User�s Guide in a PDF viewer 
such as Adobe Reader.

Licenses...
Shows a dialog with licensing information. The serial 
number of a connected Flasher may be read and licenses 
added or removed.

About... Flasher STM8 Software and company information.
Table 2.9: Help menu elements
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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Chapter 3

Settings
The following chapter provides an overview of the program settings. Both, general
and per project settings are considered.
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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3.1 Project Settings
Project settings are available from the Options menu in the main window or by using
the ALT-F7 keyboard shortcut.

3.1.1 General Settings
This dialog is used to choose the connection to Flasher STM8. The Flasher can either
be connected directly over USB to the host system, or it can be connected through
TCP/IP remotely. Refer to the Flasher STM8 manual for more information regarding
the operation of Flasher STM8.

The complexity of user interface can be selected. Select the Engineering checkbox if
you want to setup your project or the Simplified checkbox if you use Flasher STM8
Software in production environments. In the simplified user interface some options
are disabled to decrease possible error sources in the production phase.

You can specify a 
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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3.1.1.1 USB
If this option is checked, Flasher STM8 Software will connect to Flasher over the USB
port. You may change the device number if you want to connect more than one
Flasher to your PC. The default device number is 0. For more information about how
to use multiple Flasher on one PC, please refer to the Flasher STM8 User Guide.

3.1.1.2 TCP/IP
If this option is checked, Flasher STM8 Software will connect to Flasher via TCP/IP.
You have to specify the IP address of the Flasher you want to connect to.

3.1.1.3 Enable Flasher logfile
If this option is checked, you can specify a file name for the Flasher STM8 Software
logfile. The Flasher logfile will contain the same outputs as the Flasher STM8 Soft-
ware log window. You can specify one logfile per project.
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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3.1.2 CPU Settings
This dialog allows the selection of microcontroller dependent settings.

To program internal flash devices choose the respective microcontroller in the 
Device list. If your microcontroller is not found on this list, contact SEGGER as new 
microcontrollers are continuously being added.

3.1.2.1 Device
Select the respective microcontroller from the list to program internal flash devices.

3.1.2.2 Use target RAM
You may enable the use of target RAM to speed up flash operations if available for the
selected device. To use the target RAM, a start location in RAM and the amount of
RAM to be used must be entered.
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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3.1.3 Flash Settings
This dialog is used to select and configure the flash device to operate with. The listed
options of the Flash settings menu are dependent on the selection in the CPU
settings dialog.

The menu  should look similar to the screenshot below.

3.1.3.1 Base Address
You may enter the base address of the selected device. The default value is 0 which
fits for all STM8 devices.

3.1.3.2 Organization
You should select the buswidth and the number of flash chips connected to the
address and data bus of the MCU.

Normally this has not to be changed for STM8 devices.

3.1.3.3 Sector selection
The final section of this dialog indicates the sectors to be acted upon, whether they
are to be cleared, read back, or written. An individual or series of sectors may be
selected from the predetermined valid range.
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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3.1.4 Production settings
The performed actions of the auto programming feature (Target -> Auto, shortcut:
F7) can be defined in the production settings dialog. The default behaviour is Pro-
gram and Verify Complete data.
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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3.2 Global Settings
Global settings are available from the Options menu in the main window. 

3.2.1 Operation
You may define the behavior of some operations such as "Auto" or "Program & Ver-
ify".

3.2.1.1 Disconnect after each operation
If this option is checked, connection to the target will be closed at the end of each
operation.

3.2.1.2 Automatically unlock sectors
If this option is checked, all sectors affected by an erase or program operation will be
automatically unlocked if necessary.

3.2.1.3 Perform blank check
If this option is checked, a blank check is performed before any program operation to
check if the affected flash sectors are completely empty. The user will be asked to
erase the affected sectors if they are not empty.

3.2.1.4 Skip blank areas on read
If this option is checked, a blank check is performed before any read back operation 
to check which flash areas need to be read back from target. This improves perfor-
mance of read back operations since it minimizes the amount of data to be trans-
ferred via SWIM and USB or ethernet.

3.2.2 Logging
You may set some logging options to customize the log output of Flasher STM8 Soft-
ware.

3.2.2.1 General log level
This specifies the log level of Flasher STM8 Software. Increasing log levels result in
more information logged in the log window.
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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3.2.2.2 Enable DLL logfile
If this option is checked, you can specify a file name for the DLL logfile. The DLL log-
file differs from the log window output of Flasher STM8 Software. It does not log
Flasher STM8 Software operations performed. Instead of that, it logs the STM8 DLL
API functions called from within Flasher STM8 Software only.
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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Chapter 4

Command Line Interface
This chapter describes the Flasher STM8 Software command line interface. The
command line allows using Flasher STM8 Software in batch processing mode and
other advanced uses.
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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4.1 Overview
In addition to its traditional Windows graphical user interface (GUI), Flasher STM8
Software supports a command line mode as well. This makes it possible to use
Flasher STM8 Software for batch processing purposes. All important options accessi-
ble from the menus are available in command line mode as well. If you provide com-
mand line options, Flasher STM8 Software will still start its GUI, but processing will
start immediately.

The screenshot below shows the command line help dialog, which is displayed if you
start Flasher STM8 Software in a console window with FlasherSTM8.exe -help or
FlasherSTM8.exe -?
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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4.2 Command line options
This section lists and describes all available command line options. Some options
accept additional parameters which are enclosed in angle brackets, e.g. <FILE-
NAME>. If these parameters are optional they are enclosed in square brackets too,
e.g. [<SADDR>]. Neither the angel nor the square brackets must be typed on the
command line, they are used here only to denote (optional) parameters. Also, note
that a parameter must follow immediately after the option, e.g. FlasherSTM8.exe -
openprjC:\Projects\Default.jflash.

All command line options return 0 if the processing was successfully. An return value
unequal 0 means that an error occured.

Option Description

-openprj<FILENAME> Open an existing project file.

-merge<FILENAME>[,SADDR]

Merges the currently opened datafile with 
another data file (.hex, .mot, .srec, or .bin).
In case of .bin a second parameter in hex is 
needed as start addr.

-saveprjas<FILENAME> Save the current project in the specified file.
-saveprj Save the current project.

-open<FILENAME>[,<SADDR>]
Open a data file. Please note that the 
<SADDR> parameter applies only if the data 
file is a *.bin file.

-saveas<FILE-
NAME>[,<SADDR>,<EADDR>]

Save the current data file into the specified 
file. Please note that the parameters 
<SADDR>, <EADDR> apply only if the data file 
is a *.bin file or *.c file.

-save[<SADDR>,<EADDR>]
Save the current data file. Please note that the 
parameters <SADDR>,<EADDR> apply only if 
the data file is a *.bin file or *.c file.

-savecfg<FILENAME> Saves programmer config file.
-savedat<FILENAME> Saves programmer data file.
-download Downloads configuration to programmer.
-relocate<OFFSET> Relocate data by the given offset.
-delrange<SADDR>,<EADDR> Delete data in the given range.
-connect Connect to target.
-disconnect Disconnect from target.
-unsecurechip Unsecures target device.
-checkblank Blank check target.
-erasesectors Erases selected sectors.
-erasechip Erases entire flash chip.
-programverify Program and verify target.
-program Program target.
-auto Erases, programs and verifies target.
-verify Verify target memory.
-readsectors Read selected sectors.
-readchip Read entire flash chip.
-readrange<SADDR>,<EADDR> Read specified range of target memory.
-startapp Start target application.
-exit Exit Flasher STM8 Software.
-help Display help dialog.
-? Display help dialog.

Table 4.1: Flasher STM8 Software command line options
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG
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4.3 Batch processing
Flasher STM8 Software can be used for batch processing purposes. All important
options are available in command line mode as well. If you provide command line
options, Flasher STM8 Software will still start its GUI, but processing will start imme-
diately.

The example batchfile displays a message, opens a project and a data file, starts pro-
gramming and closes Flasher STM8 Software. The return value will be checked and in
case of an error an error message displayed.

Adapt the example according to the requirements of your project.

@ECHO OFF

ECHO Open a project and data file, start programming and exit
FlasherSTM8.exe -openprjC:\Projects\Default.jflash -openC:\Data\data.bin,0x4800 -
program -exit
IF ERRORLEVEL 1 goto ERROR

goto END

:ERROR
ECHO Flasher STM8 Software:  Error!
pause

:END

Note, that every call of FlasherSTM8.exe has to be completed with the -exit option,
otherwise the execution of the batch file stops and the following commands will not
be processed.
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG



33
Chapter 5

Create a new Flasher STM8 
Software project
This chapter contains information about the required steps how to setup a new
Flasher STM8 Software project.
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5.1 Creating a new Flasher STM8 Software project
Before creating a new Flasher STM8 Software project, you should have an under-
standing of your target system:

� Take a look at the schematic and the documentation of your CPU / SOC.
� Locate RAM in the chip documentation.

In the following all the necessary steps to create a project file, are explained.

1. Select File -> New Project to open a new project.
2. Open the Project Settings context menu. Select Options -> Project Settings

or press ALT-F7 to open the Project settings dialog and select the type of con-
nection to Flasher STM8.

Select Engineering (More options, typically used for setup).
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3. Choose a device from Device choice-list in the CPU dialog. Flasher STM8 Soft-
ware uses correct default values (RAM address and size) for this device. If your
device is not in the list you may have success in choosing a device which fits your
target system best.
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4. The Flash dialog should look similar to the screenshot below. Normally, all default
settings can be used without modifications.
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5. The Production dialog is secondary for a setup. You can define the behaviour of
the Auto option (Target -> Auto or shortcut: F7) which will affect the auto oper-
ation in Flasher stand alone mode.

6. Save your project (File -> Save Project) and test it.
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG



38 CHAPTER 5 Create a new Flasher STM8 Software project
Flasher STM8 Software (UM05007) © 2010 SEGGER Microcontroller GmbH & Co. KG



39
Chapter 6

Target systems
The following chapter lists all supported flash devices.
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6.1 Which devices can be programmed by Flasher 
STM8 Software?

Flasher STM8 Software can program internal flash. Flasher STM8 Software supports
all STM8 microcontrollers. The next section lists all supported micros known by the
time this document has been written.

If you need support for a chip or flash not listed in the tables below, do not hesitate
to contact us. Segger is constantly adding support for new devices. You may want to
request an updated list or have a look at http://www.segger.com for more up to date
information.
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6.2 Supported Microcontrollers
The list below gives an overview about supported microcontrollers available at the
time this document has been written.

Core MCU

STM8A STM8AF5168
STM8A STM8AF5169
STM8A STM8AF5178
STM8A STM8AF5179
STM8A STM8AF5188
STM8A STM8AF5189
STM8A STM8AF518A
STM8A STM8AF5198
STM8A STM8AF5199
STM8A STM8AF519A
STM8A STM8AF51A8
STM8A STM8AF51A9
STM8A STM8AF51AA
STM8A STM8AF6126
STM8A STM8AF6146
STM8A STM8AF6148
STM8A STM8AF6166
STM8A STM8AF6168
STM8A STM8AF6169
STM8A STM8AF6176
STM8A STM8AF6178
STM8A STM8AF6179
STM8A STM8AF6186
STM8A STM8AF6188
STM8A STM8AF6189
STM8A STM8AF618A
STM8A STM8AF6198
STM8A STM8AF6199
STM8A STM8AF619A
STM8A STM8AF61A8
STM8A STM8AF61A9
STM8A STM8AF61AA
STM8A STM8AH6126
STM8A STM8AH6146
STM8A STM8AH6148
STM8A STM8AH6166
STM8A STM8AH6168
STM8L STM8L101F2
STM8L STM8L101F3
STM8L STM8L101G2
STM8L STM8L101G3
STM8L STM8L101K3
STM8L STM8L151C4
STM8L STM8L151C6
STM8L STM8L151G4
STM8L STM8L151G6
STM8L STM8L151K4
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STM8L STM8L151K6
STM8L STM8L152C4
STM8L STM8L152C6
STM8L STM8L152K4
STM8L STM8L152K6
STM8S STM8S103F2
STM8S STM8S103F3
STM8S STM8S103K3
STM8S STM8S105C4
STM8S STM8S105C6
STM8S STM8S105K4
STM8S STM8S105K6
STM8S STM8S105S4
STM8S STM8S105S6
STM8S STM8S207C6
STM8S STM8S207C8
STM8S STM8S207CB
STM8S STM8S207K6
STM8S STM8S207M8
STM8S STM8S207MB
STM8S STM8S207R6
STM8S STM8S207R8
STM8S STM8S207RB
STM8S STM8S207S6
STM8S STM8S207S8
STM8S STM8S207SB
STM8S STM8S208C6
STM8S STM8S208C8
STM8S STM8S208CB
STM8S STM8S208MB
STM8S STM8S208R6
STM8S STM8S208R8
STM8S STM8S208RB
STM8S STM8S208S6
STM8S STM8S208S8
STM8S STM8S903K3

Core MCU
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Chapter 7

Support
The following chapter provides information about how to contact our support.
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7.1 Troubleshooting

7.1.1 General procedure
� Make sure your Flasher is working as expected. See the troubleshooting section

in the Flasher manual.
� Ensure that the target hardware matches the project file settings. Pay special

attention to the following aspects:
- RAM address
- Flash base address
- MCU

� Try to program your target device using a sample project file if available. Flasher
STM8 Software ships with an extensive number of project files for many target
boards. See section Sample Projects on page 16 for a complete list of project
files.

7.1.2 Typical problems
Failed to connect

Meaning:

This error message is shown if any error occurs during the connection process.

Remedy:

Make sure the target is actually connected to Flasher STM8 and powered. Verify the
correct connection between target and Flasher.

Blank check failed

Meaning:

The target memory was not empty during blank check.

Remedy:

Erase target memory.

RAM check failed

Meaning:

No RAM found at the specified RAM location.

Remedy:

Make sure a correct RAM address is specified in the project settings. See section CPU
Settings on page 24.

Unsupported flash type / bus width

Meaning:

The target flash memory or the bus organization is not yet supported.

Remedy:

Inform us about the device you want to use. SEGGER is constantly adding support for
new devices.

No matching RAMCode

Meaning:

There is no programming algorithm available for the selected target memory type.

Remedy:

Inform us about the device you want to use. SEGGER is constantly adding support for
new devices.
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7.2 Contacting support
If you experience a Flasher STM8 Software related problem and the advices from the
sections above do not help you to solve it, you may contact our Flasher STM8 Soft-
ware support. In this case, please provide us with the following information:

� A detailed description of the problem.
� The relevant log file and project file. In order to generate an expressive log file,

set the log level to "All messages" (see section Global Settings on page 27 for
information about changing the log level in Flasher STM8 Software).

� The relevant data file as a .hex or .mot file (if possible)
� The processor used

Once we received this information we will try our best to solve the problem for you.
Our contact address is as follows:

SEGGER Microcontroller GmbH & Co. KG

In den Weiden 11
D-40721 Hilden

Germany

Tel.+49 2103-2878-0
Fax.+49 2103-2878-28
Email: support@segger.com
Internet: http://www.segger.com
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